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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 



 

STARTER Getting Started 
Getting Started, (GS1) 07/2016, 6SL3097-4AG00-0BP4 5 

Preface  
 

SINAMICS documentation  
The SINAMICS documentation is organized in the following categories: 

● General documentation/catalogs 

● User documentation 

● Manufacturer/service documentation 

Additional information 
You can find information on the following topics at the following address 
(https://support.industry.siemens.com/cs/de/en/view/108993276): 

● Ordering documentation/overview of documentation 

● Additional links to download documents 

● Using documentation online (find and search in manuals/information) 

Please send any questions about the technical documentation (e.g. suggestions for 
improvement, corrections) to the following e-mail address 
(mailto:docu.motioncontrol@siemens.com). 

Siemens MySupport/Documentation 
At the following address (https://support.industry.siemens.com/My/ww/en/documentation), 
you can find information on how to create your own individual documentation based on 
Siemens' content, and adapt it for your own machine documentation. 

Training 
At the following address (http://www.siemens.com/sitrain), you can find information about 
SITRAIN (Siemens training on products, systems and solutions for automation and drives). 

FAQs 
You can find Frequently Asked Questions in the Service&Support pages under Product 
Support (https://support.industry.siemens.com/cs/de/en/ps/faq). 

SINAMICS 
You can find information about SINAMICS at the following address 
(http://www.siemens.com/sinamics). 
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Usage phases and their documents/tools (as an example)  

Table 1 Usage phases and the available documents/tools 

Usage phase Document/tool 
Orientation SINAMICS S Sales Documentation 
Planning/configuration • SIZER Engineering Tool 

• Configuration Manuals, Motors 

Deciding/ordering SINAMICS S120 catalogs 
• SIMOTION, SINAMICS S120 and Motors for Production Machines (Catalog 

PM 21) 
• SINAMICS and Motors for Single-axis Drives (Catalog D 31) 
• SINUMERIK & SINAMICS  

Equipment for Machine Tools (Catalog NC 61) 
• SINUMERIK 840D sl Type 1B 

Equipment for Machine Tools (Catalog NC 62) 

Installation/assembly • SINAMICS S120 Manual for Control Units and Additional System Components 
• SINAMICS S120 Manual for Booksize Power Units 
• SINAMICS S120 Manual for Booksize Power Units C/D Type 
• SINAMICS S120 Manual for Chassis Power Units, Air-cooled 
• SINAMICS S120 Manual for Chassis Power Units, Liquid-cooled 
• SINAMICS S120 Manual for AC Drives 
• SINAMICS S120 Manual Combi 
• SINAMICS S120M Manual Distributed Drive Technology 
• SINAMICS HLA System Manual Hydraulic Drive 

Commissioning • STARTER Commissioning Tool 
• SINAMICS S120 Getting Started with STARTER 
• SINAMICS S120 Commissioning Manual with STARTER 
• SINAMICS S120 CANopen Commissioning Manual 
• SINAMICS S120 Function Manual Drive Functions 
• SINAMICS S120 Safety Integrated Function Manual 
• SINAMICS S120/S150 List Manual 
• SINAMICS HLA System Manual Hydraulic Drive 
• Startdrive commissioning tool1) 
• SINAMICS S120 Getting Started with Startdrive1) 
• SINAMICS S120 Commissioning Manual with Startdrive1) 

Usage/operation • SINAMICS S120 Commissioning Manual with STARTER 
• SINAMICS S120/S150 List Manual 
• SINAMICS HLA System Manual Hydraulic Drive 
• SINAMICS S120 Commissioning Manual with Startdrive1) 
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Usage phase Document/tool 
Maintenance/servicing • SINAMICS S120 Commissioning Manual with STARTER 

• SINAMICS S120/S150 List Manual 
• SINAMICS S120 Commissioning Manual with Startdrive1) 

References • SINAMICS S120/S150 List Manual 

 1) available as of Startdrive V14 release 

Target group 
This documentation is intended for machine manufacturers, commissioning engineers, and 
service personnel who use the SINAMICS drive system. 

Benefits 
This manual provides all of the information, procedures and operator actions required for the 
particular usage phase. 

Standard scope 
The scope of the functionality described in this document can differ from that of the drive 
system that is actually supplied. 

● Other functions not described in this documentation might be able to be executed in the 
drive system. However, no claim can be made regarding the availability of these functions 
when the equipment is first supplied or in the event of service. 

● The documentation can also contain descriptions of functions that are not available in a 
particular product version of the drive system. The functionality of the supplied drive 
system should only be taken from the ordering documentation. 

● Extensions or changes made by the machine manufacturer must be documented by the 
machine manufacturer. 

For reasons of clarity, this documentation does not contain all of the detailed information on 
all of the product types, and cannot take into consideration every conceivable type of 
installation, operation and service/maintenance.  

Technical Support 
Country-specific telephone numbers for technical support are provided in the Internet at the 
following address (https://support.industry.siemens.com/sc/ww/en/sc/2090) in the "Contact" 
area. 
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Relevant directives and standards 
You can obtain an up-to-date list of currently certified components on request from your local 
Siemens office. If you have any questions relating to certifications that have not yet been 
completed, please ask your Siemens contact person.  

Certificates for download 

The certificates can be downloaded from the Internet:  

Certificates (https://support.industry.siemens.com/cs/ww/de/ps/13206/cert)  

EC Declaration of Conformity 

You can find the EC Declaration of Conformity for the relevant directives as well as the 
relevant certificates, prototype test certificates, manufacturers declarations and test 
certificates for functions relating to functional safety ("Safety Integrated") on the Internet at 
the following address (https://support.industry.siemens.com/cs/ww/en/ps/13231/cert).  

 

The following directives and standards are relevant for SINAMICS S devices: 

European low-voltage directive 

SINAMICS S devices fulfil the requirements stipulated in the Low-Voltage Directive 
2014/35/EU, insofar as they are covered by the application area of this directive. 

European machinery directive 

SINAMICS S devices fulfil the requirements stipulated in the Low-Voltage Directive 
2006/42/EU, insofar as they are covered by the application area of this directive. 

However, the use of the SINAMICS S devices in a typical machine application has been fully 
assessed for compliance with the main regulations in this directive concerning health and 
safety. 

European EMC Directive 

SINAMICS S devices comply with the EMC Directive 2014/30/EU. 

EMC requirements for South Korea 

SINAMICS S devices with the KC marking on the rating plate satisfy the EMC requirements 
for South Korea. 

Specification for semiconductor process equipment voltage drop immunity 

SINAMICS S devices meet the requirements of standard SEMI F47-0706. 

Eurasian conformity 

SINAMICS S comply with the requirements of the Russia/Belarus/Kazakhstan customs union 
(EAC). 

North American market 

SINAMICS S devices provided with one of the test symbols displayed fulfil the requirements 
stipulated for the North American market as a component of drive applications. 
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You can find the relevant certificates on the Internet pages of the certifiers: 

● For products with UL certificate (http://database.ul.com/cgi-
bin/XYV/template/LISEXT/1FRAME/index.html) 

● For products with TÜV SÜD certificate (https://www.tuev-
sued.de/industry_and_consumer_products/certificates) 

Possible test symbols 
 

      

Australia and New Zealand (RCM formerly C-Tick) 

SINAMICS S devices showing the test symbols fulfil the EMC requirements for Australia and 
New Zealand. 

Quality systems 

Siemens AG employs a quality management system that meets the requirements of ISO 
9001 and ISO 14001. 

Not relevant standards 

China Compulsory Certification 

SINAMICS S devices do not fall in the area of validity of the China Compulsory Certification 
(CCC). 

EMC limit values in South Korea 

 
The EMC limit values to be observed for Korea correspond to the limit values of the EMC 
product standard for variable-speed electric drives EN 61800-3 of category C2 or the limit 
value class A, Group 1 to KN11. By implementing appropriate additional measures, the limit 
values according to category C2 or limit value class A, Group 1, are observed. Further, 
additional measures may be required, such as using an additional radio interference 
suppression filter (EMC filter). 
The measures for EMC-compliant design of the system are described in detail in this manual 
respectively in the EMC Installation Guideline Configuration Manual. 
The final statement regarding compliance with the standard is given by the respective label 
attached to the individual unit. 
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Ensuring reliable operation 
The manual describes a desired state which, if maintained, ensures the required level of 
operational reliability and compliance with EMC limit values. 

Should there be any deviation from the requirements in the manual, appropriate actions (e.g. 
measurements) must be taken to check/prove that the required level of operational reliability 
and compliance with EMC limit values are ensured. 

Spare parts 
Spare parts are available on the Internet at the following address 
(https://www.automation.siemens.com/sow?sap-language=EN).  

Product maintenance 
The components are subject to continuous further development within the scope of product 
maintenance (improvements to robustness, discontinuations of components, etc). 

These further developments are "spare parts-compatible" and do not change the article 
number. 

In the scope of such spare parts-compatible further developments, connector positions are 
sometimes changed slightly. This does not cause any problems with proper use of the 
components. Please take this fact into consideration in special installation situations (e.g. 
allow sufficient clearance for the cable length). 

Use of third-party products 
This document contains recommendations relating to third-party products. Siemens accepts 
the fundamental suitability of these third-party products.  

You can use equivalent products from other manufacturers.  

Siemens does not accept any warranty for the properties of third-party products. 
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Ground symbols 

Table 2 Symbols 

Symbol Meaning 
 

 

 
Connection for protective conductor (PE) 

 

 

 
Ground (e.g. M 24 V) 

 

 

 
Connection for function potential bonding 

Notation 
The following notation and abbreviations are used in this documentation: 

Notation for faults and alarms (examples): 
 
• F12345 Fault 12345  

• A67890 Alarm 67890  

• C23456 Safety message 

Notation for parameters (examples): 
 
• p0918 Adjustable parameter 918 

• r1024 Display parameter 1024 

• p1070[1] Adjustable parameter 1070, index 1 

• p2098[1].3 Adjustable parameter 2098, index 1 bit 3 

• p0099[0...3] Adjustable parameter 99, indices 0 to 3 

• r0945[2](3) Display parameter 945, index 2 of drive object 3 

• p0795.4 Adjustable parameter 795, bit 4 
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Purpose of this document 
This documentation is aimed at beginners who want to find out more about the 
SINAMICS S120 drive system. The document offers a brief guide to commissioning a 
sample project with a simple SINAMICS S120 drive train. By following the instructions in this 
document, a beginner will need only a few minutes to engineer and configure the sample 
project and start up the motor.  

The sample project will be processed using a SINAMICS S120 training case. 
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 Fundamental safety instructions 1 
1.1 General safety instructions 
 

 

DANGER 

Danger to life due to live parts and other energy sources  

Death or serious injury can result when live parts are touched. 
• Only work on electrical devices when you are qualified for this job. 
• Always observe the country-specific safety rules. 

Generally, six steps apply when establishing safety:  
1. Prepare for shutdown and notify all those who will be affected by the procedure. 
2. Disconnect the machine from the supply. 

– Switch off the machine. 
– Wait until the discharge time specified on the warning labels has elapsed. 
– Check that it really is in a no-voltage condition, from phase conductor to phase 

conductor and phase conductor to protective conductor. 
– Check whether the existing auxiliary supply circuits are de-energized. 
– Ensure that the motors cannot move. 

3. Identify all other dangerous energy sources, e.g. compressed air, hydraulic systems, or 
water. 

4. Isolate or neutralize all hazardous energy sources by closing switches, grounding or 
short-circuiting or closing valves, for example. 

5. Secure the energy sources against switching on again. 
6. Ensure that the correct machine is completely interlocked. 

After you have completed the work, restore the operational readiness in the inverse 
sequence.  

 

 

 

WARNING 

Danger to life through a hazardous voltage when connecting an unsuitable power supply 

Touching live components can result in death or severe injury.  
• Only use power supplies that provide SELV (Safety Extra Low Voltage) or PELV- 

(Protective Extra Low Voltage) output voltages for all connections and terminals of the 
electronics modules. 
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WARNING 

Danger to life when live parts are touched on damaged devices 

Improper handling of devices can cause damage.  

For damaged devices, hazardous voltages can be present at the enclosure or at exposed 
components; if touched, this can result in death or severe injury.  
• Ensure compliance with the limit values specified in the technical data during transport, 

storage and operation. 
• Do not use any damaged devices. 

 

 

 

WARNING 

Danger to life through electric shock due to unconnected cable shields  

Hazardous touch voltages can occur through capacitive cross-coupling due to unconnected 
cable shields. 
• As a minimum, connect cable shields and the conductors of power cables that are not 

used (e.g. brake cores) at one end at the grounded housing potential. 
 

 

 

WARNING 

Danger to life due to electric shock when not grounded  

For missing or incorrectly implemented protective conductor connection for devices with 
protection class I, high voltages can be present at open, exposed parts, which when 
touched, can result in death or severe injury. 
• Ground the device in compliance with the applicable regulations. 

 

 

 

WARNING 

Danger to life due to electric shock when opening plug connections in operation 

When opening plug connections in operation, arcs can result in severe injury or death. 
• Only open plug connections when the equipment is in a no-voltage state, unless it has 

been explicitly stated that they can be opened in operation. 
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 NOTICE 

Material damage due to loose power connections 

Insufficient tightening torques or vibrations can result in loose electrical connections. This 
can result in damage due to fire, device defects or malfunctions. 
• Tighten all power connections with the specified tightening torques, e.g. line supply 

connection, motor connection, DC link connections. 
• Check all power connections at regular intervals. This applies in particular after 

transport. 
 

 

 WARNING 

Danger to life due to fire spreading if housing is inadequate 

Fire and smoke development can cause severe personal injury or material damage.  
• Install devices without a protective housing in a metal control cabinet (or protect the 

device by another equivalent measure) in such a way that contact with fire is prevented. 
• Ensure that smoke can only escape via controlled and monitored paths. 

 

 

 WARNING 

Danger to life through unexpected movement of machines when using mobile wireless 
devices or mobile phones 

Using mobile wireless devices or mobile phones with a transmit power > 1 W closer than 
approx. 2 m to the components may cause the devices to malfunction, influence the 
functional safety of machines therefore putting people at risk or causing material damage. 
• Switch the wireless devices or mobile phones off in the immediate vicinity of the 

components. 
 

 

 WARNING 

Danger to life due to the motor catching fire in the event of insulation overload 

There is higher stress on the motor insulation through a ground fault in an IT system. If the 
insulation fails, it is possible that death or severe injury can occur as a result of smoke and 
fire.  
• Use a monitoring device that signals an insulation fault. 
• Correct the fault as quickly as possible so the motor insulation is not overloaded. 
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 WARNING 

Danger to life due to fire if overheating occurs because of insufficient ventilation clearances 

Inadequate ventilation clearances can cause overheating of components with subsequent 
fire and smoke. This can cause severe injury or even death. This can also result in 
increased downtime and reduced service lives for devices/systems.  
• Ensure compliance with the specified minimum clearance as ventilation clearance for 

the respective component. 
 

 

 WARNING 

Danger of an accident occurring due to missing or illegible warning labels  

Missing or illegible warning labels can result in accidents involving death or serious injury.  
• Check that the warning labels are complete based on the documentation. 
• Attach any missing warning labels to the components, in the national language if 

necessary. 
• Replace illegible warning labels. 

 

 

 NOTICE 

Device damage caused by incorrect voltage/insulation tests 

Incorrect voltage/insulation tests can damage the device. 
• Before carrying out a voltage/insulation check of the system/machine, disconnect the 

devices as all converters and motors have been subject to a high voltage test by the 
manufacturer, and therefore it is not necessary to perform an additional test within the 
system/machine. 

 

 

 WARNING 

Danger to life when safety functions are inactive 

Safety functions that are inactive or that have not been adjusted accordingly can cause 
operational faults on machines that could lead to serious injury or death.  
• Observe the information in the appropriate product documentation before 

commissioning. 
• Carry out a safety inspection for functions relevant to safety on the entire system, 

including all safety-related components. 
• Ensure that the safety functions used in your drives and automation tasks are adjusted 

and activated through appropriate parameterizing. 
• Perform a function test. 
• Only put your plant into live operation once you have guaranteed that the functions 

relevant to safety are running correctly. 
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 Note 
Important safety notices for Safety Integrated functions 

If you want to use Safety Integrated functions, you must observe the safety notices in the 
Safety Integrated manuals. 

 

 

 WARNING 

Danger to life or malfunctions of the machine as a result of incorrect or changed 
parameterization 

As a result of incorrect or changed parameterization, machines can malfunction, which in 
turn can lead to injuries or death. 
• Protect the parameterization (parameter assignments) against unauthorized access. 
• Respond to possible malfunctions by applying suitable measures (e.g. EMERGENCY 

STOP or EMERGENCY OFF). 
 

 



Fundamental safety instructions  
1.2 Safety instructions for electromagnetic fields (EMF) 

 STARTER Getting Started 
20 Getting Started, (GS1) 07/2016, 6SL3097-4AG00-0BP4 

1.2 Safety instructions for electromagnetic fields (EMF) 
 

 

WARNING 

Danger to life from electromagnetic fields 

Electromagnetic fields (EMF) are generated by the operation of electrical power equipment 
such as transformers, converters or motors. 

People with pacemakers or implants are at a special risk in the immediate vicinity of these 
devices/systems. 
• Ensure that the persons involved are the necessary distance away (minimum 2 m). 
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1.3 Handling electrostatic sensitive devices (ESD) 
Electrostatic sensitive devices (ESD) are individual components, integrated circuits, modules 
or devices that may be damaged by either electric fields or electrostatic discharge. 

 

 

NOTICE 

Damage through electric fields or electrostatic discharge 

Electric fields or electrostatic discharge can cause malfunctions through damaged 
individual components, integrated circuits, modules or devices. 
• Only pack, store, transport and send electronic components, modules or devices in their 

original packaging or in other suitable materials, e.g conductive foam rubber of 
aluminum foil. 

• Only touch components, modules and devices when you are grounded by one of the 
following methods: 
– Wearing an ESD wrist strap 
– Wearing ESD shoes or ESD grounding straps in ESD areas with conductive flooring 

• Only place electronic components, modules or devices on conductive surfaces (table 
with ESD surface, conductive ESD foam, ESD packaging, ESD transport container). 
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1.4 Industrial security 
 

 Note 
Industrial security 

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly 
that you regularly check for product updates. 

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should 
also be considered. For more information about industrial security, visit this address 
(http://www.siemens.com/industrialsecurity).  

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit this address (http://support.automation.siemens.com).  

 

 WARNING 

Danger as a result of unsafe operating states resulting from software manipulation 

Software manipulation (e.g. by viruses, Trojan horses, malware, worms) can cause unsafe 
operating states to develop in your installation which can result in death, severe injuries 
and/or material damage. 
• Keep the software up to date. 

You will find relevant information and newsletters at this address 
(http://support.automation.siemens.com).  

• Incorporate the automation and drive components into a holistic, state-of-the-art 
industrial security concept for the installation or machine. 
You will find further information at this address 
(http://www.siemens.com/industrialsecurity).  

• Make sure that you include all installed products into the holistic industrial security 
concept. 
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 WARNING 

Danger to life due to software manipulation when using exchangeable storage media 

Storing files onto exchangeable storage media amounts to an increased risk of infection, 
e.g. with viruses and malware. As a result of incorrect parameterization, machines can 
malfunction, which in turn can lead to injuries or death. 
• Protect files stored on exchangeable storage media from malicious software by taking 

suitable protection measures, e.g. virus scanners. 
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1.5 Residual risks of power drive systems 
When assessing the machine- or system-related risk in accordance with the respective local 
regulations (e.g., EC Machinery Directive), the machine manufacturer or system installer 
must take into account the following residual risks emanating from the control and drive 
components of a drive system: 

1. Unintentional movements of driven machine or system components during 
commissioning, operation, maintenance, and repairs caused by, for example, 

– Hardware and/or software errors in the sensors, control system, actuators, and cables 
and connections 

– Response times of the control system and of the drive 

– Operation and/or environmental conditions outside the specification 

– Condensation/conductive contamination 

– Parameterization, programming, cabling, and installation errors 

– Use of wireless devices/mobile phones in the immediate vicinity of electronic 
components 

– External influences/damage 

– X-ray, ionizing radiation and cosmic radiation 

2. Unusually high temperatures, including open flames, as well as emissions of light, noise, 
particles, gases, etc., can occur inside and outside the components under fault conditions 
caused by, for example: 

– Component failure 

– Software errors 

– Operation and/or environmental conditions outside the specification 

– External influences/damage 

3. Hazardous shock voltages caused by, for example: 

– Component failure 

– Influence during electrostatic charging 

– Induction of voltages in moving motors 

– Operation and/or environmental conditions outside the specification 

– Condensation/conductive contamination 

– External influences/damage 

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a 
risk to people with a pacemaker, implants or metal replacement joints, etc., if they are too 
close 

5. Release of environmental pollutants or emissions as a result of improper operation of the 
system and/or failure to dispose of components safely and correctly 

For more information about the residual risks of the drive system components, see the 
relevant sections in the technical user documentation. 
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 SINAMICS S120 drive system 2 
 

 

Modular system for sophisticated drive tasks  

SINAMICS S120 solves complex drive tasks for a wide range of industrial applications and 
is, therefore, designed as a modular system. Users can choose from many different 
harmonized components and functions to create a solution that best meets their 
requirements. SIZER, a high-performance engineering tool, makes it easier to choose and 
determine the optimum drive configuration. 

SINAMICS S120 is supplemented by a wide range of motors. Whether torque, synchronous 
or induction motors, whether rotating or linear motors, all of these motors are optimally 
supported by SINAMICS S120. 

System architecture with a central Control Unit 

On the SINAMICS S120, the drive intelligence is combined with closed-loop control functions 
into Control Units. These units are capable of controlling drives in the vector, servo, and V/f 
modes. They also perform the speed and torque control functions plus other intelligent drive 
functions for all axes on the drive. Inter-axis connections can be established within a 
component and easily configured in the STARTER commissioning tool using a mouse. 
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System overview 
The SINAMICS S120 drive system consists of a variety of different modules. It is constructed 
of infeeds, filters, motor power units, modules for additional functions, Control Units plus 
standard and special versions of rotating and linear motors.  
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 Overview 3 
 

 

This manual provides instructions on how to commission a simple SINAMICS S120 drive 
based on a sample project.  

To create a sample project the following points are explained: 

1. Which hardware components do you need for the sample project? 

2. How do you create a simple project in the STARTER? 

3. How do you configure a drive? 

4. How do you put the drive into operation? 

 



Overview  
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 Hardware components 4 
4.1 Components of the example configuration 

The following components are contained within the example configuration:  

● CU320-2 DP from firmware version 4.5 with integrated Ethernet interface 

● Smart Line Module (supply module) 

● Line filter 

● Double Motor Module 

● Line reactor (for ALM and SLM) 

● Synchronous servo motor with absolute encoder and DRIVE-CLiQ interface 

● Standard PC with Windows operating system as a programming device (PG/PC), with 
pre-installed STARTER commissioning tool from version 4.3. 
The following procedure uses the Windows 7 operating system. Operation can differ 
slightly for other operating systems (e.g. Windows XP). 

● Installed motor, power, and control cables 

● DRIVE-CLiQ cables 

● Ethernet interface in the PG/PC 

● Ethernet connection between the PG/PC and the Control Unit 
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4.2 System data of the SINAMICS S120 training case 
The example configuration is performed on a SINAMICS S120 training case.  

 
Image 4-1 Training case 

The following technical data applies to the training case used:  

Structure 

Drive system comprising: 

● CU320-2 Control Unit with TB30 Terminal Board 

● Smart Line Module 5 kW, Double Motor Module 3 A 

● One 1FK7022-5AK71-1AG3 synchronous servo motor with incremental encoder sin/cos 1 
Vpp via SMC 20 

● One 1FK7022-5AK71-1LG3 synchronous servo motor with absolute encoder 2048 and 
DRIVE-CLiQ interface. 

● Reference discs for position monitoring 

 

The training case is supplied ready-to-use with a demo project on the memory card and 
documentation. 
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Technical data 
Degree of protection in accordance with DIN VDE 
0470 
Part 1/ EN 60529/IEC 529 

IP20 

Supply voltage1) • 1 AC 230 V/50 Hz 
• Via power supply adapter 1 AC 115 V 

(USA) (not supplied in the package) 

Dimensions (W x H x D) in mm 320 × 650 × 330 
Weight Approx. 30 kg 
 1) The connection conditions of the respective network operator are to be observed. 

 

 
Selection and ordering data Article No. 
Training case 
SINAMICS S120 TK-SIN-CU320-2 
2-axis design with1FK7 motors 
• With CU320-2 DP and demo project 
• With CU320-2 PN and demo project 

 
 
 
6ZB2480-0CM00 
6ZB2480-0CN00 

Power supply adapter 
1 AC 115 V / 1 AC 230 V 

 
6AG1 064-1AA02-0AA0 

Operator box SINAMICS 
(if ordered separately) 

6AG1 064-1AA01-0AA0 
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4.3 Wiring the components 
The components of this example are assembled and wired into the SINAMICS training case. 
No changes to this wiring are permitted. For the purpose of commissioning this project 
example, it is not permissible to connect other components or drive loads to the motor. 

 
Image 4-2 Wiring principle 

 

 Note 

The following description only refers to one of the two motors.  
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 Creating a drive object 5 
5.1 Overview 

This example shows how you can generate a new drive project using the STARTER 
commissioning tool. You then transfer the drive project via a communication interface to the 
Control Unit of the drive. 

For data exchange between the programming device (PG/PC) and the Control Unit (CU), an 
Ethernet interface is used in the example, which is integrated into each SINAMICS S120 
device. With PROFIBUS or PROFINET interfaces, commissioning happens in a similar way.  

The programming device and the drive (in the training case example) are switched on and 
connected to each other via a data line.  
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5.2 Setting the communication interfaces 

5.2.1 Setting up the Ethernet interface 
For the commissioning, the programming device (PG/PC) can be connected to the Control 
Unit via an Ethernet interface. However, the communications interface of the programming 
device must first be set up.  

 

 Note 

The following procedure refers to the Windows 7 operating system. Operation can differ 
slightly for other operating systems (e.g. Windows XP).  

 

Communication interface of the programming device  
1. In the programming device (PG/PC) call up the control panel via the menu items "Start > 

Control Panel". 

2. In the control panel of your programming device, under "Network and Internet", select the 
"Network and Sharing Center" function. 

3. For your network card that is displayed, click on the connection link. 

4. Click in the status dialog of the connection on "Properties" and acknowledge the 
subsequent confirmation prompt with "Yes". 

5. In the properties dialog of the connection, select the element "Internet protocol 4 
(TCP/IPv4)" and then click on "Properties". 

6. In the properties dialog, activate the "Use the following IP address" option. 
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7. Set the IP address of the access interface of the PG/PC to the Control Unit to 
169.254.11.1 and the subnet mask to 255.255.0.0. 

 
Image 5-1 Example: IPv4 address of the PG/PC 

8. Click "OK" and close the Windows-specific window of the network connections. 

5.2.2 Calling STARTER 
 

 Note 

The following procedure refers to the Windows 7 operating system. Operation can differ 
slightly for other operating systems (e.g. Windows XP).  

 

1. Click on the STARTER symbol  of your user interface. 

Or 

2. In the Windows starting menu, call the menu command "Start > STARTER > STARTER". 
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5.2.3 Assigning the Ethernet interface in STARTER 

Assigning the communication interface  
1. In STARTER, go through the menu items "Tools > Set PG/PC interface...". 

The "Set PG/PC interface" window opens: 

 
Image 5-2 Creating an access point 

2. Check the access point of the application. Here, the access point "DEVICE (STARTER, 
SCOUT) ..." must be set.  
If necessary, correct the access point using the "Access Point of the Application" drop-
down list. 

 
  Note 

The interface in our example has the designation TCP/IP -> Belkin F5D 5055 Gigabit 
USB 2.0 Network Adapter. 
However, any Ethernet interface of the PG/PC can essentially be used. 
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3. If the desired adapter is in the list, continue as described in point 6.  
If the required adapter is not included in the list, you must add the appropriate entry. To 
do so, click on the "Selection..." button. 

The already installed interfaces are located in the window "Install/uninstall interfaces". If 
the required interface is not present, you must install it yourself.  

 
Image 5-3 Selecting the interface 

4. Select the desired interface on the left-hand side, and then click on "Install-- > ". 

The interface then changes to the right-hand side. 

5. Select the required interface and close the window. 

6. Click in the list box "Interface parameter assignment used:" on the interface parameter 
assignment "TCP/IP -> Belkin F5D 5055 Gigabit USB 2.0 Network Adapter." 

7. Close the "Set PG/PC interface" window by clicking "OK." 
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5.3 Creating a drive project 
In STARTER, the project wizard will guide you through all the steps necessary to create and 
set up a new drive project. 

Procedure 
1. In STARTER, click on the menu items "Project > New with Wizard." 

The start window of the project wizard is opened. 

 
Image 5-4 Find drive units online 

2. Click on the "Find drive units online..." button. 

In step 1, the project wizard opens the "Create new project" window. 

3. Enter a name for your project, e.g. "Sample Project", in the input field. 

 
Image 5-5 Creating a new project 
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4. Click on "Continue >". 

In step 2, the project wizard opens the "Set PG/PC interface" window. 

 
Image 5-6 Setting the PG/PC Interface 

5. In this window, you can check the settings of the communication interface made in the 
previous chapter, i.e. you do not have to change anything in this window. Click on 
"Continue >". 

The project wizard searches for drive units in step 3. The drive units found are displayed 
in "Preview". 

 
Image 5-7 Insert drive units 
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6. Click on "Continue >". 

The project wizard continues to step 4 to display a summary of your project settings. 

 
Image 5-8 Summary 

7. Click on button "Complete". 

The project wizard closes the window.  

In the project navigator, the found drive unit "S120_CU320_2_DP" is then displayed under 
the sample project.  

 
Image 5-9 Drive object created 
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 Configuring the drive object 6 
6.1 Configuring the drive unit 

In the example configuration, the "S120_CU320_2_DP" drive unit is configured for operation 
in the online mode. Through automatic configuration, the drive is initially switched to the 
"Factory settings" state and then provided with a standard configuration.  

Procedure 
1. Go to the menu items "Project > Connect to selected target devices" to switch to online 

mode. 

When connecting with a target device for the first time, the target device selection is 
opened. The "DEVICE" option is activated as the access point.  

 
Image 6-1 Target device selection 
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2. Activate the desired target device and click on "OK." 

The target device selection is closed and online mode is active.  
 

  Note 
Online/offline comparison 

If you create additional projects in the same way in quick succession, the "Online/offline 
comparison" dialog appears after closing the target device selection. This dialog indicates 
that the data saved in your drive object (of the training case) does not correspond with 
the data of the new project. The reason for this is generally because you have configured 
settings in the expert list in the last project that are still saved in the target device (the 
training case), but which are missing in the newly created project in STARTER (see 
Chapter Special issues with the SINAMICS S120 training case (Page 46) and Chapter 
Commissioning a drive (Page 49)).  

However, as the online and offline configuration has to be identical, the data records have 
to be aligned.  
1. To do this, click on the "Load to PG ==>" button and confirm the subsequent "Load to 

PG" prompt with "OK." 
The "Online/offline comparison" dialog is emptied.  

2. If no more differences remain, click on "Close." 
In general, the settings required for the training case are then already available in the 
expert list (see Chapter “Special issues with the SINAMICS S120 training case 
(Page 46)” and Chapter “Commissioning a drive (Page 49)”).  

 

3. In the project navigator, click on the "+" symbol before the entry "S120_CU320_2_DP". 

The list of objects for this drive opens and looks like this: 

 
Image 6-2 Launch automatic configuration 
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4. Double-click on option "Automatic configuration" in the project navigator. 

The following window opens: 

 
Image 6-3 Automatic configuration is prepared 

5. Start the automatic configuration of the drive unit by clicking on the "Configure" button. 

The programming device (PG/PC) searches the DRIVE-CLiQ bus for connected objects. 
In the sample project, the PG/PC finds two drives. 

6. Select the entry "Servo" from the list "Default setting for all components". 

The drive in the project example is therefore used as servo control. 

 
Image 6-4 Automatic configuration drive selection 



Configuring the drive object  
6.1 Configuring the drive unit 

 STARTER Getting Started 
44 Getting Started, (GS1) 07/2016, 6SL3097-4AG00-0BP4 

7. Click on button "Create". 

The automatic configuration process commences. When the process has been 
completed, a window with the message "Automatic configuration is complete" opens. 

 
Image 6-5 Automatic configuration, stay online 

 
  Note 

The above message appears because two drives are integrated in the training case. For 
our example configuration, however, we only put one drive into operation.  

 

8. Click on the button "Stay ONLINE." 
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6.2 Configuring the Motor Module 
The Control Unit has detected the connected Motor Module and the SMI motor during the 
automatic configuration process. The device data have been transferred to the Control Unit. 
The Control Unit has automatically entered the correct device data into the parameters 
required to operate the components. 

The sample project is now ready to commission.  
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6.3 Special issues with the SINAMICS S120 training case 
 

If you use the SINAMICS S120 training case (which is customary with SITRAIN), as in the 
example case, pay attention to the following special issues: 

Motor used in the example configuration 
In this example, we only put the motor with the DRIVE-CLiQ interface into operation. The 
second motor (with incremental encoder) is ignored. 

Define infeed operating message 
 

 Note 

The settings explained below refer exclusively to the example case. If you have already 
taken data from an earlier project, only checking the parameter settings described below will 
suffice. In this regard, see also the note "Online/offline comparison" in Chapter “Configuring 
the drive unit (Page 41)”.  

 

So that you can commission the drive, you will need to define the signal source for the 
"Operating message of the infeed". In this example, we permanently set this signal to "1." 

1. In the project navigator, click on the "+" symbol before the entry "S120_CU320_2_DP". 

2. In the project navigator, click on the "+" symbol before drive "SERVO_02." 

3. Double-click on the entry "Expert list." 

4. Scroll to the right through the expert list to parameter p0864. 

 
Image 6-6 Expert list 
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5. There, click on the "0" button in the expert list. 

The following configuration dialog is opened: 

 
Image 6-7 Infeed operation 

6. Click on row "1" and then click on "OK". 

7. Go to the menu items "Project > Save" to save the example project. 
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Device supply voltage 
You must reduce the device supply voltage so that you can commission the drive. 

1. Scroll through the expert list of the drive to parameter p0210 (device supply voltage) 

 
Image 6-8 Device supply voltage 

2. In the "Online value SERVO_02", overwrite the value "600" with "300" 

3. Go to the menu items "Project > Save" to save the example project. 
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 Commissioning a drive 7 
 

 

The control panel allows you to perform basic tasks for operating, monitoring, and testing the 

drive. For operation, the symbols  (START),  (STOP), and  (TIP), and various 

diagnostic functions are available.  

You can find more information about these functions in the SINAMICS S120 Drive Functions 
Function Manual. 

ON/OFF enable 
1. In the project navigator, click on the "+" symbol before the entry "S120_CU320_2_DP". 

2. In the project navigator, click on the "+" symbol before drive "SERVO_02." 

3. Double-click on the entry "Expert list." 

4. Scroll to the right through the expert list to parameter p0840 for the ON/OFF signal. 

 
Image 7-1 On/off signal 
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5. There, click on the "0" button. 

The configuration dialog for the ON/OFF signal is opened: 

 
Image 7-2 On/off configuration 

6. Click on row "1" and then click on "OK". 
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Commission with the control panel 
1. Double-click on the entries "S120_CU320_2_DP" > "Drives" > "SERVO_02" > 

"Commissioning" > "Control Panel" in the project navigator. 

 
Image 7-3 Calling up the control panel 

The control panel is opened. 

 
Image 7-4 Control panel displayed 

2. Click on button "Assume control priority!". 
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The "Assume control priority" window opens. 

 
Image 7-5 Assuming control priority 

3. Click on button "Safety notes". 

The "Safety notes" window opens. 

 
Image 7-6 Safety instructions 

4. Read and take note of the safety notes and then close the window. 

5. In the "Assume control priority" window, click on button "Accept". 
The window is closed and the control panel is activated. 

 
Image 7-7 Control panel motor enable signal 
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6. Activate the check box "Enable signals". 

The symbols  and  are active.  

7. Enter a suitable speed for the motor in input field "n = ", e.g. "1,000." 

 
Image 7-8 Control panel motor running 

8. Click on the symbol . 

The motor accelerates to the selected example speed of 1000 rpm. The "Enables 
available" LED lights up green .  

Switching off the drive 

1. To switch-off the motor, click on the  symbol. 

The drive coasts to a standstill. 

2. Click on the "Give up control priority!" button to return the control priority. 

3. Confirm the following "Return control priority" prompt with "Yes." 

4. Go to the menu items "Project > Disconnect from target system" to end the 
communication between the PG/PC and the Control Unit. 

5. Go to the menu items "Project > Save" to save the example project to the local hard disk 
of the PG/PC. 
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 Appendix A 
A.1 List of important alarms and faults 

Axxxxx: Alarm 

Fyyyyy: Fault 

 

Table A- 1 The most important alarms and faults 

Number Cause Remedy 
F07085 Control parameters were compulsorily changed for 

the following reasons: 
• They exceeded dynamic limits due to different 

parameters. 
• They are not applicable because of properties of 

the detected hardware that are not present. 
– Fault value (r0949, interpret as decimal): 

Changed parameter number. 
– 340: The automatic calculation of the motor 

and control parameters was performed (p0340 
= 1), because the vector control was later acti-
vated as a configuration (r0108.2). 

Not necessary. 
No parameter change is necessary as the parameters 
have already been limited to a reasonable level. 

F07802 Infeed or drive does not reply a 'ready' after an inter-
nal actuation command. 
• Monitoring time too short. 
• DC link voltage not available. 
• Associated infeed or drive of the reporting compo-

nents defective. 
• Supply voltage incorrectly set. 

• Extend monitoring time (p0857). 
• Ensure the DC link voltage. Check the DC link 

voltage. Enable the infeed. 
• Replace associated infeed or drive of the reporting 

components. 
• Check settings of the supply voltage (p0210). 
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Number Cause Remedy 
F07840 The "Infeed operation" signal is not available, though 

the enables for the drive have already been pending 
for longer than the parameterized monitoring time 
(p0857). 
• Infeed not in operation. 
• Interconnection of the binector input for the 'ready' 

signal is incorrect or missing (p0864). 
• Infeed is currently identifying the network. 

• Put infeed into operation. 
• Check the interconnection of the binector input for 

the "infeed operation" signal (p0864). 
• Extend monitoring time (p0857). 
• Wait for completion of the infeed network identifi-

cation. 

A08526 No cyclic connection to the control is available. Establish a cyclic connection and activate the control 
with cyclic operation. 
On PROFINET, check the parameters "Name of sta-
tion" and "IP of station" (r61000, r61001). 
If a CBE20 is inserted and PROFIBUS should com-
municate through process data interface 1, then this 
has to be parameterized with the STARTER commis-
sioning tool or directly through p8839. 
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A.2 Restoring factory settings 
In rare cases, it may be necessary to revert the target device (the training case) back to 
factory settings. The simulated drive in the training case thus obtains a defined state once 
again and you can then restart the configuration on a secure basis. Factory settings can only 
be reached in online mode.  

Procedure 
1. Go to the menu items "Project > Connect to selected target devices" to switch to online 

mode.  

The window "Target Device Selection" opens and lists the configured drive units.  

 
Image A-1 Access point control 

2. Activate the "DEVICE" option. 
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3. Activate the check box " S120_CU320_2_DP ", and click on "OK." 

The PG/PC establishes the link to the Control Unit. It then performs an "Online/offline 
comparison". The result is displayed in the following dialog "Online/offline comparison". 
Example: 

 
Image A-2 Online/offline comparison 

4. Click on the "Close" button. 

5. Select the drive object "S120_CU320_2_DP" in the project navigator. 

6. With the right mouse button, select the shortcut menu "Target device > Restore factory 
settings." 

7. Confirm the query with "OK". 

The PG/PC sets the drive parameters to their factory settings.  

The new status is automatically transferred to the Control Unit memory card using the 
function "Copy RAM to ROM".  

8. Select the drive unit in the project navigator and go to the shortcut menu "Target device > 
Copy RAM to ROM." 

The factory settings have now been restored: the drive is in a defined basic state.  
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A.3 Documentation overview 
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